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1.Que és Mendeley?

Es una eina que combina varis aspectes: un gestor de referéncies bibliografiques, una
xarxa social académica i un cataleg col-laboratiu de literatura cientifica.

Ens permet guardar referéncies bibliografiques, gestionar-les, utilitzar-les en treballs i
bibliografies i compartir-les amb altres usuaris. També ens permet descobrir nova recerca
i crear grups publics i privats per col-laborar amb col-legues d’investigacio.

B Mendeley Institucional (MIE) és la versié que la UAB ofereix a tota la comunitat
universitaria. Aquesta ofereix prestacions superiors a les que ofereix un compte
amb la versio gratuita de Mendeley. Més informaci6 a
www.uab.cat/biblioteques/mendeley/

€2 Si deixem de tenir vinculacié amb la UAB no podrem mantenir el nostre compte

MIE. Les condicions que tindran els alumnes ja graduats (ex-alumnes o alumni) sén les prestacions
de Mendeley free. Si durant el temps que han estat a la universitat s'han fet usuari MIE, disposaran
d'un any de gracia amb beneficis MIE. Transcorregut aquest temps Mendeley avisara l'usuari que ja
no forma part del col-lectiu MIE per a que prengui les decisions oportunes. Recomanem que, abans
de deixar la universitat, els usuaris s'assegurin que en la configuracié del compte hi consta I'adre¢a de
correu personal com a adrega principal en lloc de la de la universitat.

Si el que fan és canviar d'universitat, aleshores caldra que comprovin quines condicions els ofereix la
nova universitat. Pel que fa a la pérdua d'espai per a emmagatzemar documents en cas de deixar de
gaudir de la versio MIE, en aquesta URL especifica com es desenvolupa el procés perque I'usuari no
perdi documents: http://support.mendeley.com/customer/portal/questions/2801137-downgrade-plan-
lose-documents-

[+ Apps per a dispositius mobils: iPhone i iPad, Android
(4] _Guies i videos dajuda a: http://resources.mendeley.com/ (angles) i
www.uab.cat/biblioteques/mendeley/ (Foro de la UAB)
2. Acces
2.1. Si_teniu compte Mendeley Premium i voleu passar a MIE. Aneu a

www.mendeley.com/groups/6955471/ i cliqueu Join this group.

2.2. Siteniu un compte a Mendeley free. Aneu a www.mendeley.com/groups/6955471/ i
cliqueu Join this group. Accediu al vostre compte a través de l'enllag Already on
Mendeley? Sign in. Entreu les dades del compte free i després valideu el compte amb
una adreca de correu electronic de la UAB. Rebreu un missatge a la bustia de correu
institucional que haureu de confirmar.

2.3. No sou usuaris de Mendeley. Aneu a www.mendeley.com/groups/6955471/ i cliqueu
Join this group. Seleccioneu Create a free account i ompliu les dades que us
demanen. Valideu el compte amb una adreca de correu electronic de la UAB. Rebreu un
missatge a la bustia de correu institucional que haureu de confirmar.

Un cop fet aquest tramit les seglients vegades entreu al programa a www.mendeley.com
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http://support.mendeley.com/customer/portal/questions/2801137-downgrade-plan-lose-documents-
http://support.mendeley.com/customer/portal/questions/2801137-downgrade-plan-lose-documents-
https://itunes.apple.com/gb/app/mendeley-reference-manager/id380669300?mt=8
http://ad.apps.fm/jH3dEd30ukH3t8lVtuj7VF5KLoEjTszcQMJsV6-2VnHFDLXitVHB6BlL95nuoNYfX8CxpiCxdTjfi4OpH9y6n25M618Z6zE88fDGLwazuCcFNj-jbeNcTLc71SKY8f_Q
https://itunes.apple.com/gb/app/mendeley-reference-manager/id380669300?mt=8
http://resources.mendeley.com/
http://www.uab.cat/biblioteques/mendeley/
http://www.mendeley.com/groups/6955471/
http://www.mendeley.com/groups/6955471/
http://www.mendeley.com/groups/6955471/
file:///C:/Users/0001246/AppData/0001246/Users/0001246/AppData/0001246/Configuración%20local/Refwork2/Curs/www.mendeley.com

ﬂ Més informacié a www.uab.cat/biblioteques/mendeley/

ﬂ Control d’accés per domini del correu electronic; hi ha 4 dominis admesos (uab.cat,
uab.es, e-campus.uab.cat, e-campus.uab.es). També estan admesos els correus
dels centres cresa.uab.cat, ced.uab.es/ced.uab.cat, mat.uab.cat, crm.cat, icn.cat,
ifae.es

Es pot canviar el compte de correu per accedir al compte
Web: My Account > Account details - Personal details

£ Només es pot crear un compte per persona encara que els grups (departaments,
grups de recerca....) amb un correu institucional poden disposar d’'un compte
col-lectiu

£3 Ens podem donar d’alta des de qualsevol ordinador (no cal que sigui del campus)

3. Doble plataforma : Online vs offline =
L

2 plataformes de treball connectades pel boto Sync

1. Local (Mendeley Desktop). Eina d’escriptori pensada per gestionar les
referéncies, citar i visualitzar els PDF. Necessita instal-laci6 i es pot descarregar a
www.mendeley.com/download-mendeley-desktop/. Es pot instal-lar a tots els
ordinadors que vulguem. Compatible amb Windows, Mac i Linux. Estructura de la
pantalla en columnes: esquerra (carpetes, grups i filtres), central (llistat de
referéncies) i dreta (per editar i modificar referéncies)

2. Online (Mendeley Web). Versi6 al navol (www.mendeley.com) pensada per
contactar amb altres investigadors i crear grups de treball. Estructura de la pantalla
en pestanyes: Feed (activitat dels meus contactes i grups), Library (gestié de
referencies, carpetes i visor de pdf), Suggest (suggeriment de nous documents
basant-se en els que ja tenim al nostre compte), Stats (publicacions i estadistiques
d’Scopus) i Groups. Si cerquem sobre la lupa de cerca s’obre una nova filera de
pestanyes Papers (per cercar al cataleg col-laboratiu de Mendeley), People i
Grups (em mostra els meus grups i els investigadors que segueixo 0 em segueixen
i permet cercar d’altres) i Support

m Feed Library Suggest Stats Groups Q

Papers People Groups Support

a

£2 Bona part de les tasques es poden fer indistintament amb la plataforma local i web;
pel que fa a la gestié de les nostres referéncies, Mendeley Desktop déna més
prestacions
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3 La sincronitzaci6 la fa el programa per defecte en el moment en que ens
identifiguem en el Mendeley Desktop. La resta de vegades cal que la fem nosaltres
des del Mendeley Desktop clicant en el boté Sync. Podem sincronitzar tota la base

de dades o seleccionar la/es carpeta/es que vulguem des de [Edit 2&ttings

En el moment que sincronitzem Mendeley cerca quina plataforma (Desktop o Web)
té les dades més recents i sén agquestes les que manté

B Per tancar la sessio de Mendeley Desktop (recomanable si esteu en un ordinador
public): Primer sincronitzeu; després aneu al desplegable File > Sign out. Al tornar
a entrar, en la finestra d’identificacio, podem deixar marcada o desmarcar I'opcio
Stay signed in que fa que se’ns obri la nostra sessio a I'obrir el Desktop

4. Creacio d’una biblioteca personal
Recordeu que cal sincronitzar per veure les referéncies en totes dues plataformes.
4.1 Importacié mitjancant Web Importer (Save to Mendeley)

Complement que ens permet importar referéncies i PDF des del web. S’ha d’instal-lar
entre el favorits del navegador seguint les instruccions de la pagina
www.mendeley.com/import/. En aguesta mateixa pagina trobareu les diferents webs (que
inclouen bases de dades, plataformes de revistes, cercadors, tendes online...) que
admeten aquest complement.

£3 Les referencies s'incorporen a la plataforma web. Per veure-les en Mendeley
Desktop haureu de sincronitzar.

E£3 Web importer permet descarregar les referéncies d’'una en una o totes les de la
pagina que esteu visualitzant.

€3 un cop descarregades, encara des del Web importer podeu afegir-les a una
carpeta, editar les paraules clau, etc.

£ Que puguem importar els PDF associats a les referéncies depén de si aquests son
de lliure accés o d’'una plataforma de pagament; si s6n de pagament (encara que
des de la UAB tinguem accés) no els podrem importar amb les referéncies. Els
podem guardar al nostre ordinador i posteriorment incorporar-los mitjancant Drag
and Drop o des de la columna de la dreta (visualitzacio de la referéncia) a I'apartat
Files. Si incorporem una referéncia i el seu PDF per separat el sistema els uneix

4.2 Importacié mitjancant Drag and Drop (arrossegar i deixar anar)
Permet incorporar a Mendeley Desktop referencies i PDF des de:

4.2.1 Bases de dades i revistes digitals gue no admeten el Web importer o altres eines
com Trobador+. Haurem de fer una exportacid indirecta guardant el fitxer de text
(preferiblement en format RIS) al nostre ordinador i despres arrossegar-lo a
Mendeley Desktop

4.2.2 Referéncies provinents d’altres gestors (Zotero, Refworks)

4.2.3 PDF que tinguem al nostre ordinador (provinents de bases de dades....)

4.2.4 Carpetes amb PDF i documents de text

Podem fer el mateix des de diferents botons de Mendeley Desktop: Desplegable Add
Files/Add Folder, File > Add Files, File - Import
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D Aira opcio d’importacié relacionada és mitjangant Watch Folder que permet que el
sistema importi automaticament els documents en pdf que tenim en una carpeta del
nostre ordinador

Tools>Options->File Organizer: Fa una copia al disc dur de l'ordinador dels arxius
(PDF, Words...) que tenim a Mendeley Desktop i els organitza: els anomena
seguint una pauta que nosaltres definim i també els pot ordenar en carpetes i
subcarpetes

4.3. Importacio des del Cataleg col-laboratiu de Mendeley

El cataleg col-laboratiu de Mendeley s’alimenta de:

e Les referencies que inclouen els usuaris

e Els PDF d’articles en accés obert o que els autors posen a My publications (i sobre els
guals tenen els drets)

Podem cercar a Mendeley Web clicant sobre la lupa (part superior dreta de la pantalla) i
s’obrira un grup de pestanyes entre les quals Papers

Papers People Groups Support

a

Mendeley Desktop: columna esquerra 2Literature Search
Podem importar documents relacionats amb:

- 1 document: bot6 dret del ratoli>Related documents

- Contingut de la nostra base de dades: View—>Mendeley Suggest

Normalment trobem referéncies i alguns cops el text complet associat. Hi ha referéncies
gue no incorporem el text complet. Aquest el podem cercar des de la visualitzacié del

Find this paper at: . .
document al desplegable — on també podem activar els enllacos als

recursos digitals de la UAB - Edit library access links—>Choose library from list (si
estem al campus apareix la UAB) o Add Library Manually (Si estem fora del campus.
Adreca: http://sfx.cbuc.cat/uab). Un cop activat ja ens sortira en primer lloc al desplegable
Find this paper at de tots els articles que cerquem.

B Ssino teniu els drets d’autor sobre un PDF no l'incorporeu al Cataleg Col-laboratiu
de Mendeley. Per excloure’l aneu a la visualitzacié de la referéncia a Mendeley
Desktop o Web (columna de la dreta al final). Per excloure diversos PDF de cop ho
heu de fer des de Mendeley Desktop : A la columna central ordeneu les referencies
per File Attached-> Amb Ctrl més clic seleccioneu les referéncies que voleu (amb
Ctrl + A les seleccionareu totes)—>A la columna de la dreta marqueu Unpublished
work
En Mendeley Desktop, visualitzant una referéncia, podem cercar per identificadors
(DOI, arXiv i Pubmed) i el sistema cerca en aquestes plataformes i omple
automaticament les dades de la referéncia; molt Gtil també per completar dades de
referéncies que hem importat.

£3 A Mendeley Desktop podem habilitar Mendeley Suggest que ens fa suggeriments
de documents a partir del contingut de la nostra biblioteca personal. A Mendeley
Web ho fem des de la pestanya Suggest
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4.4 Introduccié manual de referencies

A Mendeley Desktop: File - Add Entry Manually

A Mendeley Web: My library - columna central boto - Add entry manually

5. Gestionar carpetes i documents
Treballarem aquest apartat a Mendeley Desktop que dona més prestacions

5.1. Gestionar carpetes

5.1.1. Carpetes per defecte del programa

e All documents: tots els documents

e Recently added: ultimes referéncies afegides

e Recently read: ultimes documents llegits

e Favorites: referéncies marcades con favorites

e Needs review: visible quan tenim referencies, inclou aquelles referencies que
necessiten ser revisades (comprovar metadades)

e My publications: publicacions de les que som autors

e Unsorted: referencies que no tenim a cap carpeta

5.1.2. Creacio de carpetes
Create folder de la columna esquerra o - icona ~# . Per crear una subcarpeta cal

seleccionar la carpeta mare i clicar la mateixa icona.

5.1.2. Reanomenar i esborrar carpetes
Boto dret de ratoli > Rename folder o Remove folder

Una altra opci6 per esborrar carpetes - My library, seleccionar carpeta que es vol
esborrar i clicar =
5.1.3 Copiar/moure referéncies d’'una carpeta a una altra

e Per copiar referéncies en una carpeta determinada, només cal seleccionar-les i
arrossegar-les a la carpeta de desti.

e Per moure referéncies, cal suprimir la referencia de la carpeta on esta - boto
dret ratoli - remove from folder, aquesta passa a la carpeta Unsorted i des
d’aqui la podem moure a una nova carpeta

e Per veure en quinal/es carpeta/es tenim una referéncia, la seleccionem i veurem
gue les carpetes on esta inclosa es marquen de color gris

£ Quan esborrem una carpeta el seu contingut passa a la carpeta Unsorted

Les referéncies que esborrem des de la carpeta Unsorted passen a la Trash. No
s’esborren definitivament fins que no buidem la paperera

£3 Per esborrar referéncies d’'una carpeta - seleccionem la carpeta i la referencia i
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amb el botd dret del ratoli: Remove from folder (I'esborra d’una carpeta) o Delete
documents (I'esborra de totes les carpetes)

Mendeley Web

e Crear carpetes: My library > columna esquerra = 2= Folder

e Per crear subcarpetes i esborrar carpetes: My library > columna esquerra >
icona que hi ha al costat de cada carpeta

e No es pot reanomenar carpetes

o Per moure referéncies d’'una carpeta a una altra: My library > Seleccionar les

. , . , > Add to
referencies a moure i escollir carpeta o grup de desti des de > b=
situat a la columna central

e Esborrar carpetes: My library > columna esquerra - icona que hi ha al costat
de cada carpeta

5.2. Buscar i editar referéncies

5.2.1 Buscar referéncies

Seleccionem All documents si volem fer la cerca a tota la biblioteca o una carpeta en
Q-
Authars Search
Titles
Publication Names

‘e ar
concret i cerquem des de! Motes

Els resultats es poden filtrar per:

Filter by Author Keywords w

iFilker by Author Kevwaords |
Filter by Authors

Filker by Iy Tags

Filter by Publications

Els termes que cerquem surten destacats

) Cerca al text complet dels PDF

Instruccions per fer cerques avancades a través del Desktop:
http://support.mendeley.com/customer/portal/articles/227955

Mendeley Web

Pestanya My library - columna dreta

No cerca al text complet dels PDF. Busca a All documents
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5.2.2 Editar referéncies

e Ordena les referéncies per: marcats com a favorits, llegits, contenen adjunts, autor,
titol, any, titol publicacio, data afegit a Mendeley

| @ | [ Adgthors Title Year | Published In Added

e Podem canviar la visualitzacié de les referencies (columna central) a View i escollir
si les volem veure en format taula o en format de citacié (i aleshores haurem
d’escollir el format a Citation Style)

e Editar una referencia: es posem a sobre d’una referéncia. A la columna de la dreta

tenim els camps editables, pestanyes | P=tls [ Motes | podem escollir els camps
gue es visualitzen a Tools—>Options—>Document details

e Editar multiples referéncies a la vegada: seleccionem els documents que volem
editar pressionant Ctrl i fent clic - afegirem les dades que poden ser tags, notes,
etc...

e Per comprovar duplicats i validar autors, publicacions i tags anem al desplegable
de la columna esquerra (part inferior) i arrosseguem I'entrada incorrecta cap a la
correcta.

lﬁr by Authors w7 |

Fornara, 1

Foti, G

Galanopoulou, Aristea 5
izalbraith, 1.K
Galbraith, John Kenneth

El programa ens demanara confirmar els canvis

rﬂ Confirmation | ? i"j—]

Rename all instances of "Galbraith, 1.K" to
"Galbraith, John Kenneth"?

Do not ask again

[ Ok ] | Cancel

Mendeley Web

. 2 A R . a * Edit
Seleccionem una referéncia i editem els camps des de la columna dreta bot6 7 ™

No permet editar diverses referéncies a la vegada

5.2.3. Buscar referéncies duplicades

Seleccionar la carpeta o conjunt de documents on volem buscar duplicats - Tools 2>
Check for duplicates > es mostren el/s grup/s de duplicats. La barra de la columna
Confidence es mostra el grau de coincidéncia dels camps segons Mendeley.
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Des de la columna dreta podrem veure exactament quins camps sén iguals i quins no.
Si finalIment decidim fusionar les referéncies cliquem al boto

Per desfer I'accié Edit = Undo o Ctrl Z

5.3. Visor de pdf. Notes personals

Mendeley Desktop té un visor de PDF que permet crear notes, copiar una part del text i
destacar contingut dins documents PDF.
Seleccionar un arxiu PDF

> destaca un text determinat
=5 crea una nota alla on tinguem el cursor
Al ~ selecciona una part del text. Amb el botd dret del ratoli - Define podem

cercar la definicio del text que tinguem seleccionat. La font és en.wikipedia.org

Per desfer els canvis Edit = Undo o Ctrl Z

€) Les notes que hem creat sén visibles per les persones amb qui compartim la

-+
referéncia. Icona per compartir el PDF amb les referéncies

B Ttampe podem compartir el document amb un grup per a que tots els membres
puguin veure les notes. Aquestes son visibles des de la columna dreta pestanya Notes

Details Motes

Dos membres d'un grup privat poden editar de manera simultania un mateix PDF i,
gquan sincronitzin tots dos, podran veure les modificacions introduides per altres.

E3 Opcio per exportar el document amb les notes File - Export PDF  with
annotations

£2 Per imprimir un PDF: obrir-lo >File - Print. Podem imprimir-lo amb anotacions

Mendeley web

Visor de PDF que permet cercar dins el document, crear notes, copiar una part del text i
destacar contingut dins documents PDF amb les opcions del menua superior
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6. Llistar i inserir la bibliografia en un text

Tot aquest apartat es fa des del Mendeley desktop

6.1. Llistar bibliografia

Aneu a View—>Citation Style i escolliu un estil de citacio; si no veieu I'estil que voleu el
podeu trobar a More Styles - Get more Styles

Ara heu de seleccionar les referencies que voleu llistar. Per aixo a la columna de
'esquerra, apartat My Library, podeu seleccionar una carpeta o escollir All Documents...
Situeu-vos a la columna central i escolliu:

- Totes les referéncies d’'una carpeta: boté dret del ratoli > Select All (Ctrl +A).

- Algunes referéncies: Seleccioneu-les amb el punter i Shift
Un cop seleccionades amb el bot6 dret del ratoli aneu a Copy As > Formatted Citation.

Funciona igual si feu un copiar “normal” (Ctrl +C)
Obriu el processador de textos i enganxeu-les (Ctrl +V)
Si volem canviar I'estil haurem de fer tot el procediment de nou.

Per combinar estil de citacié amb la llengua de la bibliografia anar al mena View ->
Citation Style > More Styles (i al final de la finestra emergent) - triar la llengua del
desplegable Citation and bibliography language

Per defecte les referéncies incorporen URL que no corresponen a la font original (i.e: urls
dels catalegs). Com eliminar-les? Cal canviar I'opcié per defecte al Desktop - View ->
Citation Style > More Styles (i al final de la finestra emergent) - Include URLs and Date
Accessed in Bibliographies - escollir opcié Only for Webpages del desplegable

6.2 Instal-lar Mendeley Citation Plugin
Anar a Tools - Install MS Word Plugin

) cCaltenir el word tancat per instal-lar el plugin

6.3 Inserir la bibliografia en un text

S’instal-la el plugin al processador de textos. Per exemple al Word 2010 a la Pestanya
Referencias veureu:

> Style:  Chicago Manua. = | |==!

2 -E|

L Insert Bibliography
Insert Export
Citation (£] Refresh g

Mendeley Cite-C-Matic

Insert citation - cerquem la referéncia des de la pantalla emergent o anem a Mendeley
Desktop - seleccionem referéncia - icona

a Important Coses que es poden destacar ) Mendeley avancat 10




Un cop tinguem les citacions inserides, cal seleccionar Insert Bibliography per generar la
bibliografia. Si inserim noves citacions al text o canviem [’estil de citacid, la bibliografia
s’actualitza automaticament

£3 Per modificar una cita (exemple incloure la pagina), un cop inserida la citacié en el

vostre document, posicioneu-vos sobre ella. Veureu en el menu del Word de
Mendeley (Mendeley Cite-O-Matic) l'opcié Edit Citation. A la finestra emergent,
posicioneu-vos una altra vegada sobre la citaci6 que voleu modificar i us
apareixeran les opcions per editar-la. Podeu afegir, per exemple, una pagina.

Page
Prefix
SufFix

[ ] suppress author

Iy Library [H Go To Mendele-;.-'] [ (04 ] [ Cancel

Utilitzeu l'opcié Refresh quan feu algun canvi a la referéncia des del Desktop (per
exemple si canviem any, nom de l'autor....) o a Mendeley web (i posteriorment cal
sincronitzar)

Per fer cites a peu de plana: Escollim a Mendeley Desktop > View —>Citation Style
un estil propi de notes al peu com Chicago (note). Inserim la nota a peu de plana
amb les eines del word. Citem normal amb Mendeley

B 6.4 Personalitzar estils de citacions

Des de Mendeley Desktop - View - Citation styles - More styles

€3 Més informacié:  http://support.mendeley.com/customer/portal/articles/895771-

getting-started-with-the-visual-csl-editor

! ] Important nCoses que es poden destacar [} Mendeley avancat

Per comencar a fer un nou estil de citacié podem agafar un existent i amb el boto dret
del ratoli anar a Edit style. Ens haurem d’identificar

La seguient pantalla que apareix és el Visual Editor CSL. Podem clicar sobre el camp
de la citacié que volem canviar; a la part inferior de la pantalla veurem els canvis que
podem realitzar.
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7. Treballar en grup

Encara que també es pot fer a Mendeley Desktop treballarem aquest apartat des de
Mendeley Web
7.1 Crear grups

Els grups us permeten compartir informacio i col-laborar amb altres usuaris de Mendeley.
3 Tipus:

Private Invite only Open

Qui? Només els membres Tots poden veure i seguir. Tots poden veure,

veuen el contingut Només els convidats poden | seguir, afegir
afegir referencies i referéncies i comentar.
comentar.

Queée? Referencies i text complet | Referencies Referéncies

Permet | Compartir en privat Compartir referéncies o Fer bibliografies
documents i notes bibliografia recomanada. col-laboratives o

Té opcio RSS: alerta només | seguiment d’un tema.
sobre els papers Té opcid RSS: alerta
només sobre els papers

Ideal per | Grups de recerca Professors (fer visibles les Usuaris de Mendeley

bibliografies)

Icones Administrador del grup Usuaris demanen formar Usuaris poden unir-se al
convida els membres part del grup o sén grup o només seguir-lo
convidats per administrador 4. Join this group

Follow this group
‘ Follow this group
‘ Ask to join this group
€3 Més informacio:  http://support.mendeley.com/customer/portal/articles/227903-

what-are-groups-on-mendeley-

e Per crear un grup > Pestanya Groups -

o Per editar les caracteristiques del grup (afegir imatge, assignar tags, etc.) - pestanya
Settings

e Perincorporar referencies a un grup vegeu 5.1.3 Copiar/moure referéncies d’'una
carpeta a una altra

@) Amb el compte MIE es poden fer fins a 1.000 grups amb un maxim de 25 membres
cadascun
L'espai d'emmagatzematge per a grups és de 20 GB; I'espai compartit dels grups
només es descompta a la persona que ha creat el grup, no als altres membres

E2 Des de Groups - Settings podem editar els grups amb invitacid i fer-los publics, i a
la inversa. No podem passar els grups privats a publics ni amb invitacio

£ Que els membres del grup obert o amb invitacié puguin veure i descarregar els
PDF associats a les referéncies depén de si aquests sén de lliure accés o d’una
plataforma de pagament

, ., Share E
€3 Amb l'opcié Share | L |
podem compatir amb xarxes socials

podem obtenir I'url escurcada del grup i

O3 Des de Share > Embed on other sites podem crear el widget del grup i incrustar-

a Important ﬂCoses que es poden destacar ) Mendeley avancat 12
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lo en webs, blocs, etc.

Mendeley Desktop
Columna esquerra—> Groups—> Create group

Per canviar les caracteristiques del gruplEdit =ttings

7.2. Cercar grups i persones

7.2.1.Cercar grups
A la pestanya Groups podem veure els nostres grups i cercar altres que ens interessin.
També podem cercar grups des del quadre superior de cerca

Papers People Groups Support

a

Podem seguir els grups, participar-hi (en els oberts) o demanar participar-hi (en els
grups amb invitacio)

7.2.2. Cercar persones

Podem cercar altres investigadors clicant sobre la lupa a la part superior de la pantalla:
Papers People Groups Support

a

Es poden seguir perfils personals i estar al dia de les actualitzacions. Només es fara
publica informacié que estigui aixi definida als perfils personals.

Com a propietaris del nostre perfil també podem decidir qui acceptem com a seguidor
clicant sobre el desplegable situat al costat del nostre nom (part superior dreta de la
pantalla) - Privacy 2

Followers

Cnly let people whom | approve follow me

7.3. Sobre els drets d’autor

Cal respectar les llicéncies dels proveidors a I'hora de fer publics els articles. Respecte als
grups privats vinculats al CBUC, en general es poden compartir articles per a usos
acadéemics i no comercials.

Cada usuari és responsable de I'is de la documentacié que posa a Mendeley, no la
institucio.

3 Més informacio: http://www.mendeley.com/terms/
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8. Altres eines

8.1.Create/restore backup

e Per crear la copia de seguretat des de Mendeley Desktop -> Sync la base de
dades per tal de fer la copia de la versié més recent (web o desktop) > Help - Create
backup. Es genera una carpeta zip MendeleyBackup

e Per restaurar I'arxiu Help - Restore backup - Triar I'arxiu i verificar I'accio “I want to

restore all my data”

rﬂ Restore Mendeley Des. .. w

This will delete all vour Mendeley data
(stored locally and on Mendeley Web)
and restore wour library From the
selected backup.

This feature should not be used For

migrating your library hetween
computers

If wou are sure vou wank to do this,
please type the Following text into the
b below:

I want ko restare all my daka

Restore My Data

) 8.2. Sincronitzacié Mendeley-ORCID

ORCID és un web que ens permet identificar-nos com autor de publicacions cientifiques a
partir d’'un codi alfanuméric. Si estem registrats a ORCID i a Mendeley mitjancant
I'aplicacio http://m2id.org/top podem exportar les publicacions que tenim a Mendeley a la
carpeta My publications, a la carpeta Obras en ORCID. Es a dir, ens permet exportar

aqguelles publicacions de les quals som autors.

e Ens hem de registrar a ORCID i assegurar-nos de tenir Mendeley Web-Desktop

sincronitzat

e Aneu a http://m2id.org/top, cliqueu sobre l'enlla¢ Sign in with orcid i seguiu les

instruccions

e Un cop sincronitzats recordeu que cada cop que afegim una obra propia a la
carpeta My publications de Mendeley hem d’anar a http://m2id.org/main i prémer

Sync. Refresquem la pagina a ORCID i ja veiem les noves incorporacions

! ] Important nCoses que es poden destacar

[} Mendeley avancat
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